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1. Introduction

Immerse Virtual Studio Signature Edition includes two Virtual studios which can be unlocked
either by individual purchase or together through the Mix and Master Bundle:

e Alan Meyerson

e Lurssen Mastering

This suite includes both plugins and a Standalone version of Immerse Virtual Studio, as well
as the Immerse Audio Bridge for multichannel routing between applications.

Immerse Virtual Studio Signature Edition

Get the tools you need to mix and master immersive content like the professionals.
Powered by the Immerse Al HRTF personalization engine and certified by industry
legends Alan Meyerson and Lurssen Mastering, this plugin allows you hone your
production skills in stereo, surround, and Atmos in up to 7.1.6 channels on
headphones from inside two realistic virtual environments that are tuned to your ears.

Immerse Virtual Studio Signature Edition Standalone + Immerse Audio Bridge
For ultimate flexibility, monitor your Dolby Atmos mix on headphones with the
external Dolby Renderer using your personalized HRTF, or listen to multichannel
audio from any compatible output source including media players.

This manual contains all the information you'll need to get started with Immerse Virtual
Studio Signature Edition.

2. Quick Start Guide

For those who are already familiar with Immerse Virtual Studio and want to get
started in a flash, here are the basic steps to get started.



1 Overview

1. Download and install the Immerse software for PC or Mac

2. Launch the Immerse software and enter your email address. Use the
PIN code (6 digits) received on your email to finalize the identification
process.

3. Scan the QR Code with your mobile device, and follow the instructions
to submit a picture of your right ear.

4, Return to Immerse, and finalize your setup.

5. Open your preferred Steinberg DAW, select a track and instantiate
Immerse Signature Edition plugin

6. Open the plugin Ul. Select your favorite studio from a list of world
class studios. From the headphone menu, select your favorite headphones

7. You are now ready to start listening!



3.1 System Requirements

1.

Compatibility and Minimum System Requirements:

Software Format : Plug-in and Standalone
Plug-in Types : AAX, VST3 and AU
Max Sample Rate : 192 kHz

Compatibility :

Win OS : Windows 10 and 11
Mac OS L 10.9.x and above
Mac M1, Mac M1 Pro

Minimum System Requirements :
Processor : Intel Core 2 Duo
Memory : 4GB

Disk Space : 650MB

3.2 Installation

1.

3. Getting Started

Download and open “ImmerseVirtualStudioSignatureEdition-1.0.0.22.exe”

for Windows and “ImmerseVirtualStudioSignatureEdition-1.0.0.21.pkqg” for

MacOS.

‘E‘ Setup - Immerse Virtual Studio Signature Edition 101.0.0.3

License Agreement
Please read the following i i ion before continuil

with the installation.

Please read the following License Agreement. You must accept the terms of this agreement before continuing

Please review and agree to the License Terms and Conditions

= X

i

and Privacy Policy.

(:)I accept the agreement
@)I do not accept the agreement

Cancel




2. Please read and agree to the license terms and privacy policy.

3. You will then see Release Notes for this software version. Once read, please
press Next

fi
Information
Please read the following important information before continuing.

When you are ready to continue with Setup, click Next.

Version 101.0.0.3

< Back Cancel

4. Select if you want a desktop shortcut to be created, then press Next

I
Select Additional Tasks
‘Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing Immerse Virtual Studio Signature
Edition, then click Next.

Additional shortcuts:
Create a desktop shortcut

< Back Cancel

5. Click on the Install button to proceed with the Installation.



il
Information
Please read the following important information before continuing.

When you are ready to continue with Setup, dlick Next.

Version 101.0.0.3

< Back Cancel

6. The installation is now complete. Please press Finish to exit Setup

@ Setup - Immerse Virtual Studio Signature Edition 101.0.0.3 —

Completing the Immerse Virtual Studio
Signature Edition Setup Wizard

Setup has finished installing Immerse Virtual Studio Signature Edition on
your computer. The application may be launched by selecting the installed
shortcuts.

Click Finish to exit Setup.

IMMERSE

VIRTUAL STUDIO

3.3 Uninstallation

1. For Mac OS open “ImmerseVirtualStudioSignatureEdition-XXXXX.pkg”
select the Customize tab under the Installation Type menu option, and then
select “Uninstall Immerse Virtual Studio Signature Edition”



[ ] & Install Immerse Virtual Studio Signature Edition 101.0.0.8 &}

Custom Install on “Macintosh HD"

Package Name Action Size

jotieduction Install Immerse Virtual Studio Signature...

Read Me ¥ Uninstall Immerse Virtual Studio Signatur... Install Zero KB

Licence
Destination Select

@® Installation Type

Space Required: Zero KB Remaining: 344,11 GB

IMMERSE

| VIRTUAL STUDIO Standard Install Go Back Install

2. For Windows, go to “Apps & Features”, select Immerse Virtual Studio
Signature Edition, and then click on Uninstall

3.4 Instantiating Immerse Virtual Studio Signature Edition

1. You can insert the Immerse Virtual Studio Signature Edition plugin on any track.
Typically you'll want to instantiate Immerse on the last stage of your mastering chain,
whether that be a stereo or multichannel track or bus. You can find the Immerse
Virtual Studio plugin under plug-in -> Embody -> Immerse Virtual Studio with Avid.
Alternatively, you can find the plugin under “Sound Field”.

3.5 Onboarding a new user

You can onboard a user with either the standalone application or within the plugin
Ul. The process described below is identical for both paths.

1. Enter your email address to begin.



!I!:JTLI:lLESBUSDIE 57?”1%% éfﬂé’/%

Welcome to Immerse Virtual Studio.
Mix anywhere with your favorite headphone!

Please enter your email address to begin.

Begin

2. After entering your email address, you’ll be required to enter a PIN code that
you should have received to your email. If for some reason you have not
received the email with the PIN, please click Resend PIN.

il WNERSE Sigpesitivss Ebifion

We sent a PIN number to demo@embodyvr.co. Please enter it below.

Next

Resend PIN

3. Scan the QR Code with your Mobile phone by opening your phone’s camera
and holding it in front of the QR code.



IMMERSE Spuitinre Ediion

Scan this QR code with your phone's
camera to make your Personalized HRTF

Waich Video Done

4. Allow your mobile phone to open the browser window when prompted. A
web page will then provide you the appropriate instructions to record a video
of your ears, which will then be used to calculate your personalized HRTF

CENTER YOUR FACE IN FRAME Without moving your phone, look one way —

The border will turn green when accepted. pause—and the’n t‘hif‘he_r' I M M E R S E

Powered by Embody

Ready To Go!

Once recording has finished, your video will
automatically upload.

After uploading, you will receive a unique
code which you can enter in the software to
Personalized HRTF Profile.

era still durin:
e best ¢

Start Capture

Tutorial @ Tutorial Tutorial

AA B¢ @& -autocapture.embodyvrio X AA B¢ & autocapture.embodyvrio C AA B¢ @ autocapture.embodyvrio C

M an © M m © M m O

5. Once you are ready, press “Start Capture”

10



] IMMERSE

Success!

We have created a personalized audio

profile based on your ear.

Please return to the Immerse

software to complete the setup!

AA 8 gr-autocapture.embodyvr.io ¢ AA @ immerse-grapp.embodyvrio C

h m O < M m O

Upon Success, return to Immerse on your machine. Your personalized profile
will download automatically. Once done you will see the screen below.

[ WMERSE Signoctivse Eudition

Your personalized profile
is ready to go! Get Started!

11



7. Click “Get Started” to open the main Ul of Immerse Virtual Studio. You'll then be

presented with a quick tutorial to help you get started!.

Options  Binaural Render

Audio input is muted to avoid feedback loop

Tutorial 1/6

Your profile is a Head Related
Transfer Function (or HRTF)
created from a picture of your ear.
Your personalized HRTF models
how sound reflects around your
head and ears and enters your
eardrum, to give you the most
accurate spatial listening
experience on headphones.

Leam More.

User Profile

demo@embodyvr.co

demor+se@embodyvr.co

My Studios

Lurssen Mastering
License Type
14-Day Trial

Alan Meyerson

14-Day Trial 4outof§

12



4. Usage and Features

Options Binaural Render Imm tual Stud ture Edition

A ; < &Y st
' Generic Open-Back ~ LE:‘TE:LESBU%E (‘_).,14,1 {{:‘f/j.g_..-w Colitvon

Hide Studio Hide Controls View Selecter  {Surround) Studio

Studios . {Char:ﬂel 712SMPTE  a Main  Inputs Headphones Limiter o Alan Meyerson's Studio M
onfiguration ik

Remote Control Prods, Santa Monica

b About Studio M, Remote Control Prods

"Studio M" is part of Hans Zimmer's Remote
- i Control Productions studio complex in Santa
EHRAsEN }1‘ar.5,li§2ny35termg 14 - Menica, where Alan Meyerson and Zimmer
have had a long-standing working relationship.
The complex boasts seven buildings of studios,
composer suites, and mix rooms. Zimmer
invited Meyerson to take over the former Studio

C, and rebuild it to be his personal mix and
a0 recording room. In 2009, after a structural and
% Alan Meyerson 14 design overhaul, "Studio M" was born. Since
7.1.8 + Film Scores

Ambience % 9 @

VIRTUAL PRODUCTION FOR STEREO, SURROUND, AND ATMOS

Get the tools you need to mix and master immersive content like the professionals.
Powered by the Immerse Al HRTF personalization engine and certified by industry
legends Alan Meyerson and Lurssen Mastering, this plugin allows you hone your
production skills in stereo, surround, and Atmos in up to 7.1.6 channels on
headphones from inside two realistic virtual environments that are tuned to your ears.

13



4.1 Inserting IVS Signature Edition plugin in your session
4.1.1 Inserting IVS Signature Edition in Nuendo / Cubase

Open the Channel Settings for the desired track where you want to add the plugin, then
open the inserts menu to view all available plugins. You'll find the plugin under Spatial ->
Surround -> Immerse Virtual Studio Signature Edition. It is generally advised to place
Immerse on the last step of your monitoring chain.

f Channel Settings : Audio 01 [stereo] N

Stereo In v & || Audio 01 - Stereo Out v| | ®

Channel Strip Equalizer Cue Sends

Default T —_ v |5 = .M,V.M, »| [ @ | [& v\ -
Comp EQ Tools Sat Limit
SR

b Ambisonics

> Analyzer

» Delay

b Distortion

» Dynamics

> EQ

> Filter

> Mastering

» Modulation

> Network

b Other

» Pitch Shift

b Reverb

¥ Spatial

¥V Surround

Dolby Atmos Binaural Settings
Immerse Virtual Studio Alan Meyersc

Q 1.0
Immerse Virtual Studio Signature Edi Audio 01
Reveal Immerse Virtual Studio Signature Edition

Destinations Panning
b Spatial + Panner
5 Stereo Out 7.1.2 Out
> Surround

4.1.2 Inserting IVS Signature Edition in Wavelab

While working on an Audio Montage when mastering your mix, you may want to insert
Immerse Virtual Studio Signature Edition in the output effects of the Master Output. To do so:
1. Open the plugin chain window, then click on Output
2. Select an empty effects slot and click on the Effects Option icon

14



Montage Output

Master Effects

Menu B ¥ 04

Effect Options

Tell me more

3. Find Embody plugin vendor and select “Spatial: Surround: Up-Downmix: Immerse
Virtual Studio Signature Edition”

<

Update Peak Files

Map Waveform to Level

Embody d: Up % rse Virtual Studio Signature Edition

F'_”_LI'JI !i.i:‘

Voxengo

4. Once selected, the plugin main window will open and show up as follows

15



Generic Open-Back ~

Channel
Configuration

Studios TA2SMPTE &

Lurssen Mastering s

7.4.4 « Mastering

LURSSEN

Alan Meyerson
7.1.6 « Film Scores

IMMERSE S iorse Enifion

VIRTUAL STUDIO

Hide Studio

Main

Inputs

Hide Controls

Ambience

Headphones

View Selector (Surreund) Studio

Limiter

Upper  Lowiar

demo+se @ -

Lurssen Mastering
Burbank, CA

About Lurssen Mastering

Lurssen Mastering is a world-renowned multi
Grammy award-winning mastering studio. They have
mastered many gold and platinum records and have
received a number of industry awards. In addition to
the Grammys earned and proudly displayed by
Lurssen Mastering, numerous songs worked on by
the team have been nominated for Oscars over the
years and several have won this prestigious award.

@000

5. Once done, you should be able to select the studio and settings of your preference

and listen to your montage through VS Signature Edition.

6. If you would like to monitor the output of multiple Wavelab projects through Immerse
simultaneously, we recommend routing audio from Wavelab to the standalone

version of Immerse.

4.2 User Profile

16



Options Binaural Render Immerse Virtu

*i‘ Generic Open-Back ~ IMM E RS E §l{(7‘p¢.,

VIRTUAL STUDIO

User Profile

demo+se@embodyvr.co

My Studios
sen Mastering

14-Day Trial 4outof5

Alan Meyerson

@ Ao Meyerson Bypassed
Your trial of this studio has expired.

Uniick Shade Hide Studio Hide Controls View Selector  (Slound) Studio

Studios Channel - 5 syipTE - Main  Inputs Headphones Limiter

Configuration Help £ Email Support Play Tutorial

o
7 EMBODY

1 COPYRIG! oDy

Lurssen  LUssen Mastering 3

7.1.4 - Masteri TR,

’ - have had a long-standing working relationship.
The complex boasts seven buildings of studios,
composer suites, and mix rooms. Zimmer
invited Meyerson to take over the former Studio
C, and rebuild it to be his personal mix and

Y recording room. In 2009, after a structural and

Alan Meyerson design overhaul, "Studio M" was born. Since

®0O

7.1.6 + Film Scores

1. Click on the user icon E to display the user information for all the users logged
into the plugin.

2. Activate . If you are a Trial user, you'll need to Activate the product and
enter your license code before your trial expires. To do this, click on “Activate”.

3. New user : Click on “+” to add a new user. Clicking on “-” will delete the
selected user. Note that this will delete all the user information including the HRTF.

4. Your username (email ID) used for login will also be displayed in this menu. Click on

the 'next to the email to see all the other information related to licenses, remaining
images, etc.

5. License Type : The duration of your trial or license is displayed here.

Devices Remaining : You are allowed to login and use the suite in 5 different
machines. The number of devices remaining is displayed here.

17



Images Remaining : A single user is allowed a total of 5 different images. The
number of images remaining is displayed here.

Remaining New |
ew Image

My Studios

Lurssen Mastering

License Type D es Remaining

14-Day Trial 4 out of 5

Alan Meyerson

License Type Devices Remaining

14-Day Trial 4 out of 5

6. Days Remaining : Find the number of days remaining in your Trial or purchased
license for each Signature Studio within the Studio selection window, next to a
Calendar icon.

--'—I"_ - 1

Alan Meyerson o
d 7.1.6 » Film Scores

7. New Image : Click here to submit a new image. You will then scan the
QR code displayed to take a picture of your right ear. In future versions, you will be
able to audition and select the image that sounds best to you.

8. Help : Click on Help to open a detailed FAQ for this product
Email Support : If you have any questions, click on “Email Support” to email our
support channels and we will get back to you very soon. All the information regarding
your license will automatically be populated.
Play Tutorial : Click on “Play Tutorial” to play a walkthrough tutorial. At any point of
time, if you want to skip, you can do so by clicking the “Skip” button.

Help ] Email Support Play Tutorial

18



9. Click on the logo to open the product webpage. The product version is also displayed
here.

o
 ENMBODY

v2.0.0 COPYRIGHT 2022 EMBODY

4.3 Studio View

Options Binaural Render Immerse Virtu

Generic Open-Back ~ IMMERSE <

VIRTUAL STUDIO =~

)

pl“i - i“li‘
o T Ny

\

Hide Studio Hide Controls View Selector (Surround ' Studio

You can Solo and Mute each speakers by clicking on their corresponding icons. Single click
a speaker to Solo, Right click to Mute. You can also set the Exclusive or Latch behavior in
the Advanced Settings option.

4.4 Headphone EQ

1. Click on the headphone graphic to open the headphone preset selection tab. You
have a total of 36 headphones to select from, and universal presets if your specific
model is not available. Headphone EQ is necessary to maintain the true sound
quality of the original source.

2. You can search for your headphones by name or any other key words.

19



3. Click on the headphone brand to see the list of headphones available for that
particular brand.

AKG

Audeze
Audio-Technica
beyerdynamic
Sennheiser
Sony

Other Headphones

4.5 Studio Controls

Studios annel 4o oupTE A Main  Inputs Headphones  Limiter Alan Meyerson's Studio M

Chany
Configuration Remote Control Prods, Santa Monica

il About Studio M, Remote Control Prods

3 "Studio " Is part of Hans Zimmer's Remote
i Control Productions studio complex in Santa
N I;u‘r ir:"z\/lasterlng 14 5 Monica, where Alan Meyerson and Zimmer
have had a long-standing working relationship.
The complex boasts seven buildings of studios,
= » 2 composer suites, and mix rooms. Zimmer
“’ i | invited Meyerson to take over the former Studio
C. and rebuild it fo be his personal mix and

] recording room. In 2008, after a structural and
%{/ Alan Meyerson design overhaul, "Studio M" was bor. Since

716 + Fim Scores
Ambience % @

1. Channel Configuration : Select your desired channel configuration from a list of
available formats. As you select a particular format, only the studios compatible with
the format will be enabled.

2. Studio Menu : Choose your preferred virtual studio from this list. Not all studios
support the same channel configurations, so make sure you select the one that’s
right for your specific needs. Each studio will need to be unlocked separately unless
you've purchased the Mix and Master Bundle.

3. Clicking on “S” will solo the Lower speakers by default. Click on “Upper” or “Lower” to
solo the Upper or lower set of speakers.

Upper Lower Reset

20



4. Double clicking the speaker globes will Solo the corresponding speaker. Single click
will give the option of muting or soloing the respective speaker. Right click will Mute
the speaker. Select the Exclusive or Latch behavior from the advanced settings.

Upper Lower

5. Ambience : Toggle Ambience on/off to enable or disable the studio’s natural reverb.
You can also adjust the value to control the amount of reflections in the studio as
desired.

Ambience 40%

6. Master gain : Adjust the slider to control the output master gain value. Generally
you'll want to leave this set to unity to ensure an accurate representation of your
project’s overall volume.

7. Inputs : You can adjust the levels of each of the speaker outputs individually from the
Inputs tab. This can be done either by adjusting the slider or manually inputting the
desired value..

21



Main  Routing Headphones  Limiter o

In1 2 3 45 6 7 8 9 1011 1213 14 15 16

Out L R € LFE Ls Rs Lrs Rrs Ltf Rf Ltr Rir

8. Headphones Tab : You can enable or disable theHeadphone EQ in the headphones
tab. In addition, you can adjust the amount of headphone EQ by adjusting the slider.
We recommend setting it at around 60%.

4.6 Limiter

Main  Inputs Headphones Limiter Q

Headphone Settings

Headphone EQ

Main Inputs Headphones Limiter

Peak Limiter

Input Gain 0.0dB  Threshold
L]

Release Output Ceiling

Limiter Overload Protection

Limiter
1. You can turn the Limiter on/off by toggling the button next to “Limiter” -

2. Input Gain : You can set the input gain to the limiter by adjusting this slider.

3. Threshold

: Threshold determines when limiting begins, while output ceiling

specifies how much limiting is applied. When the threshold is low, even relatively
low-level signals will undergo gain reduction, while a high threshold will yield a more
measured response.

22



4. Release : The release control determines how quickly the limiter stops working after
the signal drops below the threshold. If it is overly long, you will hear audible
pumping, while if it is too short, distortion artifacts may result.

5. Output Ceiling : The output ceiling is the limit that your audio signal doesn't
cross. In practice, you want this level to be below 0 dBFS to prevent any digital
clipping. Before you start tweaking any settings, we recommend that you set the
output gain limit to somewhere between -0.2 dBFS and -0.02 dBFS.

6. Limiter Overload Protection : You can turn overload protection on/off by toggling
this button. This tab also allows you to see when the limiter is engaged or not.

4.7 Advanced Settings

Main Inputs Headphones Limiter Q

Advanced Settings

HRTF Intensity 6

Center Balance 0.00 LFE Lowpass Filter 105Hz
|
-— -
Speaker Delays
Minimum Phase Response

Bypass During Offline Bounce To Disk

Solo Behavior | Latch Exclusive

1. HRTF Intensity : Controlling the HRTF intensity adjusts the level of spatialization
being applied to your signal. Higher levels of HRTF intensity will improve the
accuracy of spatial localization at the expense of some sonic clarity. Lower levels of
HRTF intensity have the opposite effect, improving sonic clarity while reducing the
spatial localization effect.

2. Center Balance : If your L/R balance seems off, adjust this slider to make sure the
Center is perceived right in the middle.

3. LFE lowpass Filter : This determines the LFE low-pass cutoff frequency that is
applied to the LFE channel. Note that this value is different for each studio as it is set
to match the exact LFE characteristics of that particular studio.

4. Speaker Delays : Some studios manually add speaker delays to each of the
speakers to match the acoustics of a cinema theater. You can turn on the Speaker
Delays by toggling the button next to Speaker Delays. We recommend Speaker
Delays to be turned off especially when you are panning.

23



5. Minimum Phase Response : Turning this On means the HRIRs being applied are
minimum phase response in nature. The perceptual difference between on vs off is
often very subtle.

6. Bypass During Offline Bounce to Disk : Turning this On will bypass the plugin
when you are bouncing the audio in your DAW. Alternatively, you can disable the
plugin at the channel input level.

7. Solo Behavior : In Latch mode, soloing multiple speakers one after the other will not

unsolo the previous speaker. In Exclusive mode, only one speaker can be soloed at a
time.

24



5. Standalone Application

The standalone version of Immerse Virtual Studio Signature Edition is ideal for use with
external applications outside your DAW. This is the version you’ll want to use if you intend to
route audio from your DAW to the external Dolby Atmos Renderer. You can also use this
version to route multichannel audio to your headphones from any compatible application,
including media players such as VLC..

5.1 Immerse Virtual Studio Signature Edition Standalone
running on Mac OS

5.1.1 Setup Immerse Virtual Studio Signature Edition Standalone

1. Go to your Launchpad or Applications folder and search for Immerse Virtual Studio
Signature Edition. Click on the application to launch the Immerse Virtual Studio
Standalone application. This desktop application allows you to route multichannel or
Atmos audio between applications and monitor that signal on any pair of headphones.

2. When you set Channel Configuration to a desired value, only those studios which are
compatible with that specific channel configuration will be enabled and the rest will be
disabled (grayed-out). For example :

Channel Configuration 7.1.6 is only supported by Alan Meyerson Studio M.

; A o ) .
Studios chﬁgﬂfaﬂuﬂnen' Shme Main  Inputs Headphones  Limiter Alan Meyerson's Studio M
Remote Control Prods, Santa Monica

b About Studio M, Remote Control Prods

. "Studic M" is part of Hans Zimmer's Remote
. LUI‘SSEH Masterin y Control Productions studio complex in Santa
LURSSEN 9 14 -5 Monica, where Alan Meyerson and Zimmer
have had a long-standing working relationship.
The complex boasts seven buildings of studios,

7.1.4 « Mastering

- composer suites, and mix rooms. Zimmer
| w invited Meyerson to take over the former Studio

L
b C, and rebuild it to be his personal mix and

: 40 recording room. In 2009, after a structural and
%{/ Atan Meyerson 14 ] design overhaul, "Studio M" was born. Since

7.1.6 + Film Scores:
Ambience % e @
Gan 0

3. To configure the Input/Output in the Immerse Virtual Studio Surround Standalone App
Click on Options -> Audio/MIDI Settings on the top left corner.

25



Options Binaural Render Immerse Virtual Studio Signature Edition - X
Audio/MIDI Settings...

—

1“‘ Save Preset M !/!:!rUMALE SBU%IE W’t/@@ 6/:0517«1/0’)’!/ demotse @ -~

Save Preset As...
Open Preset...

Reset to Default State

4. Select the Input of the standalone app as “Immerse Audio Bridge”. Immerse Audio

Bridge is a virtual audio cable that enables various other applications such as the Dolby

Atmos Renderer to route audio to Immerse.. Immerse Audio Bridge is installed

automatically when you install the application (Step 1).

Select Sample Rate as 48000 Hz, and Audio buffer size as 512 samples.

Make sure you select the correct Output device that routes to your headphones.

7. In order to avoid any feedback, the audio input is muted by default. Make sure you
unmute it when you playback.

@ o

Binaural Render Immerse Virtual Studio Signature Edition

Generic Open-Back ~ @ Audio/MIDI Settings

Feedback loop:

Output: MacBook Pro Speakers
Input: Immerse Audio Bridge

v Inputl+2

e v Input 3 + 4
Active input channels:
v Input5 + 6

v Input?7 + 8

Sample rate: 48000 Hz

Audio buffer size: 512 samples (10.7 ms)

Channel sen Masterin
Configuration 7.1.2 SMPTE  CA 9

1t Lurssen Mastering

n Mastering is a world-renowned
rssen Masteri ng 4 ny award-winning mastering studi
" Mastaring | red many gold and platinum recorf
=d a number of industry awards. |
ammys earned and proudly displa
i Mastering, numerous songs woj
im have been nominated for Osc4
and several have won this prestigi

Ambience 6 @

5.1.2 Setup Immerse Virtual Studio Signature Edition Standalone with
Nuendo / Cubase (on Mac)

1. In Nuendo, go to Studio Setup -> Audio System, and select “Immerse Virtual Studio
Signature Edition” as the ASIO driver.
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) @ Studio Setup

Devices Audio System

+ Add Device [ ASIO Driver Immerse Audio Bridge

* D Release Driver when Application is in Background

Immerse Audio Bridge Input Latency 5.333 ms

Output Latency 5.333 ms

Z Chord Pads ASIO-Guard Latency 32.000 ms

HW Sample Rate 48.000 kHz
@ MIDI Port Setup

HW Pull Up/Down Off
) MIDI Remote P

@ Track Quick Controls » Advanced Options
[ vsT Quick Controls

e Record Time Max
e SyncStation

e Time Display

2. Please ensure that the number of channels in the output is correctly set. For
example, in order to listen to a 7.1.2 track on Immerse Virtual Studio Standalone app:

a. Go to Studio -> Audio Connections, and create a 7.1.2 output bus named
“7.1.2 Out’. Make sure that this new bus is set to Main Mix, and that the
connected Audio Device is “Immerse Audio Bridge”.

b. Open the channel settings for the track you want to monitor through Immerse
Standalone and make sure the output is set to “7.1.2 Out” bus

[ ] @ Audio Connections - Outputs
Inputs Outputs Group/FX External FX External Instruments Control Room

Add Bus | Presets No Preset v Expand All Collal

Not Connected

‘ Immerse Audio Bridge
e -, T ssee——
‘ Immerse Audio Bridge 1

Immerse Audio Bridge 3
Immerse Audio Bridge 4 |
Immerse Audio Bridge 5
Immerse Audio Bridge 6
Immerse Audio Bridge 7

Immerse Audio Bridge 8
op Side Left Immerse Audio Bridge 9
op Side Right J Immerse Audio Bridge 10

3. You can now play your Nuendo / Cubase audio on the IVS Signature Edition
Standalone application!
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5.1.3 Setup Immerse Virtual Studio Signature Edition Standalone with
Wavelab (on Mac)

1. In Wavelab, go to File -> Preferences -> Audio Connections

W Ovew @ eom & INSERT B PROCESS correcTion {3 specTRUM ANALYZE D RENDER
L2 7 al

CURRENT FILE
: e

® info W Clobal mmerse Audio Bridge Y Port Names. Control Panel, ¥4 Refresh
) Audio Connections
3 New & Shortcuts
7 Open - Plug-ins
Surround
&, import © Remote Devices a 7.1.2 (LR CLFE Ls Rs SI 5t Tsl Tsr)

3 Folders

R Variables

I %) Podcast

2. Select “Immerse Virtual Studio Signature Edition” in the Audio Device drop down
menu
3. Under Channel Configuration:
a. Select the appropriate configuration of your audio mix (in this example,
“Surround” is selected)
b. Select the desired channel configuration (in this example, 7.1.2 is selected)
4. Now, in the Speaker Table, make sure all speakers used in your mix are connected to
an Immerse Audio Bridge (IAB) port
5. Open Immerse Virtual Studio Signature Edition Standalone application, go to
Midi/audio settings and then select Immerse Audio Bridge (WavelabPro11.exe) as
the Monitoring Source.
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6. Make sure your Audio Output device’s sample rate configured in IVS Signature
Edition matches the Wavelab project sample rate, and you should be ready to listen
to your Wavelab project through the IVS Signature Edition standalone application!

5.2 Immerse Virtual Studio Signature Edition Standalone
running on Windows

Unlike Mac Immerse Virtual Studio with Avid Standalone, the standalone version in windows
is an ASIO driver that takes in multichannel input and binauralizes the output.

5.2.1 Setup Immerse Virtual Studio Standalone with Nuendo / Cubase
(Windows)

1. On Nuendo, go to Studio Setup -> Audio System, and select “Immerse Virtual Studio
Signature Edition” as the ASIO driver
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In Immerse Virtual Studio Signature Edition Standalone application, open Options ->

Audio/MIDI Settings.

a. Select Monitoring Source “Immerse Audio Bridge”
b. Select Audio device type according to where you will be listening the mix on.

As an example:

i.  Output: Headphones (Realtek ® Audio)

i.  Input: None

c. Select your sample Rate (default 48kHz should work fine)
d. Audio buffer size : 512 is recommended for 44.1 and 48 kHz. For higher
sample rates, please select a buffer size of either 1024 or 2048 samples.

30



il Audio/MIDI Settings x

Feedback loop:

Monitoring source: Immerse Audio Bridge (Nuendol2.exe) v

Output: Speakers (Realtek(R) Audio) v Test

Input: << none >>

Sample rate: 48000 Hz

Audio buffer size: 512 samples (10.7 ms)

Setup Guide Help With Sample Rate

In Nuendo / Cubase, please ensure that the number of channels in the output is
correctly set. For example, in order to listen to a 7.1.2 track on Immerse Virtual
Studio Standalone app:

a. Go to Studio -> Audio Connections, and create a 7.1.2 output bus named
“Immerse 7.1.2”. Make sure that this new bus is set to Main Mix, and that the
connected Audio Device is Immerse Virtual Studio Signature Edition.

b. Open the channel settings (the track you want to monitor through Immerse
standalone), and make sure the output is set to “Immerse 7.1.2” bus.
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4. You can now play your Nuendo / Cubase audio on the IVS Signature Edition
Standalone application!

5.2.2 Setup Immerse Virtual Studio Standalone with Wavelab

6. In Wavelab, go to File -> Preferences -> Audio Connections (Ctl+Shift+P)
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CURRENT FILE
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7. Select “Immerse Virtual Studio Signature Edition” in the Audio Device drop down
menu
8. Under Channel Configuration:
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a. Select the appropriate configuration of your audio mix (in this example,
“Surround” is selected)
b. Select the desired channel configuration (in this example, 7.1.6 is selected)
9. Now, in the Speaker Table, make sure all speakers used in your mix are connected to
an Immerse Audio Bridge (IAB) port
10. Open Immerse Virtual Studio Signature Edition Standalone application, go to
Midi/audio settings and then select Immerse Audio Bridge (WavelabPro11.exe) as
the Monitoring Source.
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7. Make sure your Audio Output device’s sample rate configured in IVS Signature
Edition matches the Wavelab project sample rate, and you should be ready to listen
to your Wavelab project through the IVS Signature Edition standalone application!
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11. Troubleshooting
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